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Overview 

PSG (Pipe Support Generator) is an advanced software solution designed to 

streamline and enhance the process of creating pipe support designs. 

Specifically tailored for industrial applications in sectors like oil and gas, power 

plants, and petrochemicals, PSG empowers users to produce high-quality 3D 

CAD models and 2D fabrication drawings with exceptional speed and accuracy. 

Key Features 

• Efficient Model Generation: PSG can generate approximately 2,000 2D 
fabrication drawings and 3D CAD models daily using a single PC or laptop, 
ensuring unmatched Pipe Supports Supportivity. 

• Versatile File Formats: Seamless creation of 3D CAD models in various file 
formats compatible with your design workflows. 

• Detailed Fabrication Drawings: Precise 2D fabrication drawings for every 
pipe support, ready for manufacturing. 

• Bill of Materials (BOM): Automatic generation of comprehensive BOMs 
for each support, detailing materials and quantities. 

• Weight and Surface Area Calculations: Accurate measurements of weight 
and surface area for each part, aiding in cost estimation and material 
planning. 

• Sheet Metal Development: Flattened development of all sheet metal 
parts for manufacturing. 

• Comprehensive Support Documentation: Complete assembly collections 
and detailed drawings for all support marks. 

Integration and Compatibility 

PSG integrates seamlessly with Autodesk Inventor versions 2020 through 2025, 

ensuring a robust platform for efficient design workflows. 

Unmatched Efficiency 

With PSG, users can produce: 

• A detailed 3D CAD model, 

• A 2D fabrication drawing, and 
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• A comprehensive Bill of Materials (BOM) in just 30 to 50 seconds per 

design. 

Why Choose PSG? 

PSG revolutionizes the CAD design process by significantly reducing design time, 

improving accuracy, and minimizing resource utilization. By automating 

repetitive tasks, PSG enables designers and engineers to focus on innovation and 

quality while meeting the highest standards of precision and efficiency. 

 

Purpose of This Manual 

This manual serves as a comprehensive guide to help you: 

1. Understand the core features and functionalities of PSG. 

2. Navigate the software interface with ease. 

3. Create high-quality models and drawings efficiently. 

4. Maximize the software's capabilities for enhanced Pipe Supports 

Supportivity. 

Whether you are a first-time user or an experienced professional, this manual is 

designed to equip you with the knowledge and skills to get the most out of PSG. 

Copyright, Licensing, and Disclaimer 

Copyright 

PSG (Pipe Support Generator) software and its associated content, including but 

not limited to the software code, documentation, designs, and icons, are the 

exclusive intellectual property of [Ahmed Hegazy & SE CAD Solutions]. All rights 

are reserved. Unauthorized copying, distribution, or modification of the 

software or its components is strictly prohibited. 

Licensing 
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PSG is available under a cloud-based licensing model designed to provide 

flexibility to users based on their project timelines and needs. Licenses are 

offered in the following subscription durations: 

• 3-Year Subscription 

• 1-Year Subscription 

• 6-Month Subscription 

• 3-Month Subscription 

• 2-Month Subscription 

• 1-Month Subscription 

All licenses include access to software updates and technical support for the 

duration of the subscription. Renewal notifications will be provided before the 

subscription period ends. 

Disclaimer 

The PSG software is provided "as is," without warranty of any kind, either 

express or implied, including but not limited to the implied warranties of 

merchantability and fitness for a particular purpose. While every effort is made 

to ensure accuracy and reliability, [SE CAD Solutions] shall not be held liable for 

any direct, indirect, or consequential damages arising from the use or inability to 

use the software. 

It is the responsibility of the user to verify that the output from PSG meets 

project specifications and industry standards. 

For detailed terms and conditions, please refer to the End User License 

Agreement (EULA) included with the software package. 

 

 

System Requirements 
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PSG is designed to operate efficiently without demanding high-end hardware 

specifications. However, since PSG runs within the Autodesk Inventor 

environment, it is essential that your system meets the Autodesk Inventor 

system requirements for versions 2020 to 2025. 

Minimum System Requirements 

To ensure a smooth experience with PSG, your system should meet the 

following baseline requirements: 

• Operating System: 

Windows 10 (64-bit) or newer. 

• Processor: 

64-bit Intel® or AMD® multi-core processor with SSE2 support. 

• RAM: 

At least 8 GB (16 GB or more is recommended for complex projects). 

• Graphics: 

Microsoft® DirectX® 11 compliant graphics card with at least 2 GB of 

VRAM. 

• Storage: 

Minimum 40 GB of free space for Autodesk Inventor installation and PSG 

software files. 

• Internet: 

A stable internet connection is required for license activation, updates, and 

cloud features. 

• Software: 

Autodesk Inventor 2020, 2021, 2022, 2023, 2024, or 2025 must be 

installed on your system. 

Recommended System Requirements 

For optimal performance when working on large-scale projects: 

• Processor: Intel® Core™ i7 or AMD Ryzen™ equivalent. 
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• RAM: 32 GB or more. 

• Graphics: A high-performance GPU with 4 GB or more of VRAM, such as 

NVIDIA Quadro or AMD Radeon Pro series. 

• Storage: SSD with sufficient space for project files and backups. 

Additional Notes 

• Ensure your system is up-to-date with the latest Windows updates and 

drivers, particularly for graphics cards. 

• Autodesk Inventor’s official system requirements may vary slightly with 

version updates. Refer to Autodesk’s website for the most accurate and 

detailed specifications. 

By meeting these requirements, users can take full advantage of PSG's 

capabilities and ensure seamless integration with Autodesk Inventor. 

 

 

Installing on Your Computer 

This section provides a step-by-step guide to installing PSG software on your 

computer. Ensure your system meets the minimum system requirements before 

proceeding. 

Step 1: Download the Installation Package 

1. Visit the official SE CAD Solutions website or the download link provided in 

your purchase confirmation email. 

2. Download the PSG installation package compatible with your version of 

Autodesk Inventor (2020–2025). 

Step 2: Prepare for Installation 

1. Ensure Autodesk Inventor is installed and functional on your system. 

2. Close all running applications to avoid conflicts during installation. 
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3. Disable any antivirus software temporarily, as it might interfere with the 

installation process. 

Step 3: Run the Installer 

1. Locate the downloaded installation file (e.g., PSG.exe) and double-click it 

to begin. 

2. Follow the on-screen instructions: 

o Select the installation directory (default is recommended). 

o Agree to the End User License Agreement (EULA). 

3. Click Install to begin the process. 

Step 4: Activate Your License 

1. Once installation is complete, run PSG from your desktop. 

2. The PSG Login window will appear. 

3. First-Time Users: 

o If this is your first time using PSG, you will need to register. 

o Click on the Register button and fill in all the required data, such as 

your name, email address, and company details. 

o Create a strong password and submit the form. 

o After registration, you will get 15 days as an evaluation period. 

4. Returning Users: 

o If you already have an account, simply log in using your email and 

password. 

Notes: 

• Contact us to activate your account (secadsolutions@gmail.com & 

contact@secadsolutions.com) 

• If you encounter any issues during activation, please contact technical 

support. 

mailto:secadsolutions@gmail.com
mailto:contact@secadsolutions.com
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Troubleshooting 

• If PSG does not running over Autodesk Inventor, ensure that the version of 

Inventor you are using is supported. 

• Contact technical support if activation fails or if you encounter installation 

errors. 

Uninstallation 

To remove PSG: 

1. Open the Control Panel in Windows. 

2. Navigate to Programs and Features. 

3. Select PSG and click Uninstall. 

4. Follow the prompts to complete the removal. 
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Getting Started with PSG 

Welcome to PSG! This section will guide you through the initial steps to get up 

and running with the software, from installation to creating your first 3D model. 

1. Launching PSG 

After installing PSG and activating your license, you are ready to launch the 

software. Follow these steps to get started: 

• Locate PSG: Open PSG from your desktop shortcut or the Start menu. 

• Create a new Project: Select a support Mark type from the supports list 

and select path in your machine. 

• Initial Screen: Upon launching, the software will load the main interface, 

where you can start working on your Pipe supports designs. 

 

2. User Interface Overview 

The PSG (Pipe Support Generator) User Interface (UI) is thoughtfully designed to provide 

users with an efficient and organized workspace. It is divided into three main areas, each 

focusing on specific aspects of the pipe support design process. 

1. Support Marks Data Area 

Located on the left-hand side of the UI, this area is dedicated to managing the data for 

support marks. By default, it includes the following three columns: 

• Support Mark: Displays the unique identifier for each pipe support. 

• Quantity: Indicates the number of units required for each support. 

• Painting Code: Specifies the required paint or surface treatment for each support. 

Users can enhance this area by adding additional columns from the Optional Value - 

Shortcut Menu, which include: 

• Unit: Identifies the unit within the project where the support mark is required. This is 

useful for breaking down complex projects into manageable segments. 

• Area: Indicates the specific area within the project where the support will be 

installed, ensuring clear organization in large-scale projects. 
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• Line: Refers to the piping line that the support mark is associated with, aiding in 

accurate placement and project coordination. 

This customizable layout ensures users can adapt the data area to align with their project's 

specific requirements, improving both clarity and efficiency. 

2. Accepted Support Marks Area 

Located on the top-right side of the UI, this area displays the Accepted Support Marks. 

These support marks meet the project's predefined specification data, indicating they are 

ready for use in the design. This section enables users to focus on compliant and approved 

designs, facilitating smooth project progress. 

3. Rejected Support Marks Area 

Located on the bottom-right side of the UI, this area lists the Rejected Support Marks. 

These are the support marks that do not match the specification data, highlighting 

discrepancies that need to be addressed. By isolating these entries, PSG ensures users can 

quickly identify and resolve issues to maintain project integrity. 

 

 

3. Adding Components to Your Project 

PSG makes it easy to add data to the Support Marks Data Area by either 

importing data directly from an external Excel sheet or using the copy-and-

paste method. Follow the steps below to seamlessly integrate your data: 

 

Option 1: Importing Data from an External Excel Sheet 

1- Prepare Your Excel File: 

• Ensure your Excel file contains the necessary columns, such as Support Mark, 

Quantity, Painting Code, and any optional columns like Unit, Area, or Line. 

• Verify that the data is formatted correctly to match your project specifications. 

2- Access the Import Command: 

• Right-click within the Support Marks Data Area to open the Shortcut Menu. 

• Select the Import option from the menu. 
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3- Locate and Select the File: 

• In the file explorer window, navigate to the location of your Excel sheet. 

• Select the file and click Open. 

4- Map the Columns (if required): 

• Match the columns in your Excel file to the corresponding columns in PSG. 

• Confirm your selection and click Import. 

5- Review the Imported Data: 

• Verify that the imported data is correctly populated in the Support Marks Data Area. 

• Make any adjustments as needed. 

 

Option 2: Copy and Paste from Excel 

1- Select Data in Excel: 

• Open your Excel file and select the cells you want to add to PSG. 

• Ensure the data includes all necessary columns. 

2- Copy the Data: 

• Right-click the selected cells and choose Copy, or use the shortcut Ctrl+C (Windows). 

3- Paste Data into PSG: 

• Right-click in the Support Marks Data Area of PSG and choose Paste from the 

Shortcut Menu. Alternatively, use Ctrl+V (Windows). 

4- Verify the Data: 

5. Check that the pasted data aligns correctly with the existing columns. 

6. Make any necessary edits directly within PSG. 

 

4. Data Validation 

Before starting your project, it is essential to perform data validation to ensure 

that all Support Marks comply with the specified requirements. PSG offers a 

built-in validation feature to help users identify accepted and rejected support 
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marks. This step allows for corrections before proceeding with project creation, 

ensuring accuracy and efficiency. 

 

Steps for Data Validation 

1. Navigate to the Validation Command: 

o From the Top Menu, click on the Project tab. 

o Select the Validation option from the dropdown menu. 

2. Run the Validation Process: 

o Once you select the Validation command, PSG will analyze the data in the 

Support Marks Data Area. 

o The system will compare each support mark against the project specifications 

and criteria. 

3. Review the Results: 

o After the validation process is complete: 

▪ Accepted Support Marks: 

▪ These marks, which meet all specifications, will appear in the 

Accepted Support Marks Area at the top-right of the PSG 

interface. 

▪ Rejected Support Marks: 

▪ These marks, which do not meet the specifications, will be 

displayed in the Rejected Support Marks Area at the bottom-right 

of the PSG interface. 

4. Resolve Issues for Rejected Marks: 

o Review the rejected marks and identify the reasons for non-compliance. 

o Make the necessary corrections in the Support Marks Data Area directly or in 

your source data (e.g., Excel file). 

o Re-run the validation process to confirm that all issues have been resolved. 

 

Benefits of Data Validation 
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• Error Identification: Quickly highlights any discrepancies or issues with support 

marks. 

• Efficiency: Ensures that only compliant data is used in the project, reducing errors 

during project execution. 

• Improved Accuracy: Helps maintain project standards by validating support marks 

against specified criteria. 

 

5. Modifying Components 

PSG allows users to easily modify the details of a support mark directly within 
the Support Marks Data Area. This feature provides flexibility to make 
adjustments and ensures that the project data is always accurate and up-to-
date. 

 

Steps for Modifying Components 

• Locate the Support Mark to Modify: 
o Navigate to the Support Marks Data Area on the left-hand side of the PSG user 

interface. 
o Identify the support mark and the specific cell you want to edit. 

• Edit the Required Cell: 
o Click on the cell that contains the value you want to change (e.g., Support 

Mark, Quantity, Painting Code, or additional project-related columns like Unit, 
Area, or Line). 

o Enter the new value directly into the cell. 
o Press Enter to save the changes. 

• Perform Data Validation: 
o After making modifications, it is recommended to validate the updated data to 

ensure compliance with project specifications: 
▪ Go to the Top Menu, select the Project tab, and click on Validation. 
▪ Review the updated results in the Accepted Support Marks Area and 

Rejected Support Marks Area to confirm the changes are valid. 
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5. Saving Your Work 

It’s always a good idea to save your work regularly: 

• Step 1: Click File > Save to save your project for the first time. 

• Step 2: After saving, click File > Save to save any subsequent changes. 

 

6. Exporting Your Design 

PSG provides a seamless way to generate and export all necessary outputs for 
your project, including 3D models, 2D fabrication drawings, detailed Bills of 
Materials (BOM), and surface area calculations. These outputs are essential for 
manufacturing and project execution, particularly for tasks like painting and 
material estimation. 

 

Steps for Exporting Your Design by Autodesk Inventor 

1. Prepare the Support Marks Data: 
o Ensure all required support marks have been added and validated in the 

Support Marks Data Area. 
o Confirm that any necessary modifications have been made, and the data is free 

of errors. 
2. Access the Build Command: 

o Go to the Top Menu and select the Project tab. 
o Click on the Build option to initiate the export process. 

3. Start the Design Export Process: 
o PSG will begin creating: 

▪ 3D Models: Detailed CAD models of the support marks in your specified 
file format. 

▪ 2D Fabrication Drawings: Precise technical drawings for manufacturing. 
▪ Bills of Materials (BOM): A comprehensive list of materials required for 

each support mark. 
▪ Surface Area Calculations: Detailed surface area, useful for tasks like 

paint estimation. 
4. Review and Save the Outputs: 

o Once the process is complete, review the generated files to ensure accuracy. 
o Save the outputs to your desired location for further use or distribution. 
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7. Using Help and Support 

If you ever need assistance: 

• In-Software Help: Access the built-in help system by clicking the File > 

Manuel. This will open the Instruction Manuel for detailed instructions on 

all PSG features. 

• Online Tutorials: Visit our YouTube channel for more resources, including 

Tutorials. 
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Support Mark Types in PSG 

PSG provides a diverse range of support mark types to cater to various 

requirements in pipe support design. Each support mark type serves a specific 

function in the project, helping users efficiently design and model different types 

of supports based on the project needs. PSG also supports two different 

specifications, TEN and Ergo Praxis, allowing for flexibility depending on the 

project's requirements and client preferences. 

 

Support Mark Types in PSG 

1. Welded Supports 

o These supports are designed to be welded directly to the pipe or 

structure. They are ideal for heavy-duty applications where a strong, 

permanent attachment is required. 

o Commonly used for large diameter pipes or in high-stress 

environments. 

2. Clamped Supports 

o Clamped supports are used when there is a need to secure a pipe 

without welding. They offer flexibility and ease of installation, as well 

as the ability to adjust and remove the clamp as necessary. 

o Ideal for smaller pipes or situations where the support needs to be 

non-permanent. 

3. Itemized Supports 

o These are customizable supports that are listed with specific details 

for each component. Itemized supports are often used for specialized 

designs, where precise adjustments are needed to meet project 

requirements. 

4. Structural Supports 
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o Structural supports are designed to be used in conjunction with the 

overall structure of the building or plant. These supports often 

involve heavier components that tie into the building’s framework. 

o They provide strong support for pipes and are essential for complex, 

multi-level systems. 

5. Vessel Supports 

o Vessel supports are used to secure piping systems attached to 

vessels, such as tanks, pressure vessels, or reactors. These supports 

must accommodate the dynamic loads and stresses that come with 

attaching piping to moving or pressurized vessels. 

6. Dynamic Supports 

o Dynamic supports are designed to absorb motion or vibration in 

systems. These are critical in environments where pipes are subject 

to thermal expansion, seismic activity, or other forces that could 

cause movement. 

7. Small Bore Supports 

o Small bore supports are used for smaller pipes (typically with a 

diameter of less than 4 inches). These supports are lighter and more 

compact, designed to maintain the integrity of small piping systems 

in a confined space. 

8. Large Bore Supports 

o Large bore supports are used for larger pipes, typically greater than 4 

inches in diameter. These supports must be strong and able to handle 

the increased load from heavier pipes or systems. 

9. Cold Supports 

o Cold supports are used for pipes that carry very low-temperature 

fluids. These supports are designed to prevent thermal expansion 

and ensure the pipe remains stable in environments where the 

temperature is extremely low. 
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Specifications in PSG 

PSG includes two primary specifications that define the requirements and design 

criteria for the support marks: 

1. TEN Specification 

o The TEN specification is commonly used for certain industries and 

regions, with its own set of design criteria and standards for pipe 

support systems. 

2. Ergo Praxis Specification 

o The Ergo Praxis specification is an alternative, providing additional or 

different design approaches based on specific customer needs or 

engineering practices. 

o It offers flexibility and a more tailored approach depending on the 

client’s operational requirements. 
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7. Troubleshooting Common Errors 

In this part of the instruction manual, we will discuss some of the common 

errors and how to troubleshoot them. 

• Language Configuration Issues: 

If you face an issue during project creation or when the build completes 

without any action in Autodesk Inventor, it indicates that the system 

language must be set to English (United States). 

 
Kindly open start button and wright “Language Setting”  

 

 
 

1. Open the Start Menu and type Language Settings. 

2. Change the display language to English (United States). 

3. Restart your computer. 

4. Launch SEG again and retry. 
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• Symbol Display and Formatting Error 

Before lunching SEG you will need to be sure from the Symbol formatting. 

 

1. Modify the Regional Settings: 

o Open Control Panel > Region 

o Under the Formats tab, click Additional settings... 

o Ensure the Decimal Symbol is set to "." (dot) instead of "," (comma) 

o Apply the changes and restart your computer 
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• Migration Option - Saving form (for each parts, assemblies and drawings) 

appearance. 

If you receive a save confirmation message for each file type—Part, 

Assembly, or Drawing—similar to the message shown in the image, this 

indicates that Autodesk Inventor’s Migration setting is preventing 

automatic updates. 

 

 
 

 
 

To resolve this issue, you need to adjust the Migration Option. 

Please follow the steps below: 
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1. Go to the Tools tab. 

2. Click Application Options. 

3. Open the Save tab. 

4. Find the Migration setting. 

5. Change its value from No to Yes. 

6. Apply to Save the changes.  

This will allow Inventor to automatically update and save migrated files 

without prompting you for each item. 
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• Whitelist and Server Synchronization Error 

If you receive a message stating that you need to be connected to the 

internet while you are already online, it means SEG is being blocked from 

reaching the server. 

To resolve this issue: 

 

1. Whitelist the following URLs and IP addresses in your firewall/antivirus 

or network settings: 

o https://license.secadsolutions.com/Account/Login 

o http://secadsolution.com/Account/Login 

o 154.41.209.210 

o 208.98.35.168 

2. Retry launching SEG. 

o If the issue persists, it indicates that something (most likely your 

antivirus software) is still blocking SEG from sending requests to 

our servers. 

3. Check with antivirus software: 

o Temporarily disable your antivirus and try running SEG. 

o If SEG works correctly, then re-enable your antivirus and ask your 

IT team to whitelist the above URLs and IP addresses within the 

antivirus configuration. 

     

If you still facing the same message 

please navigate to the following path and share the updated 

psg_application.log file with secadsolutions@gmail.com: 

C:\Users\[Your Username]\AppData\Local 

This will help us verify the update and assist you further if needed. 

  



Pipe Support Generator V3 
 

26 | P a g e  
 

Visual Reference: 
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Examples 

 

A06 Support Group 

Step 1: Create a new Project 

 

 

Step 2: Select A06 Support Group after that select the project directory. 

Step 3: Click create button to create the project folder and needed files. 
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Step 4: From the samples file which located in the installation directory of PSG 

software, open A06 excel sheet and copy all date to PSG or you can import the 

file from the shortcut menu and select the directory of the excel file. 

 

Step 5: After importing the file, make a validation for the imported data. 
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Step 6: Check if you have a rejected support marks or not, and check the 

accepted support marks. 

 

 

Step 7: From Project tab select Build to create all items inside PSG tree 

 

 

Step 8: After Creating the 3D model of the Pipe Support and the 2D Drawing, 

you can open both separately from the node shortcut menu. 
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Step 9: You can Export both of the 3D model, 2D Drawing and Sheet metal 

Development from the shortcut menu. 
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Select the exporting directory 

The following images for the available formats for Assembly and drawing 

that you can export 
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Step 10: You can create a collection assembly which includes the all-support 

marks in your project with the required quantities. 
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Step 11: You can create a collection of drawings in a single drawing with a 

multiple sheet. 
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B04 Support Group 

Step 1: Create a new Project 

 

 

Step 2: Select B04 Support Group after that select the project directory. 

Step 3: Click create button to create the project folder and needed files. 

Step 4: From the samples file which located in the installation directory of PSG 

software, open A06 excel sheet and copy all date to PSG or you can import the 

file from the shortcut menu and select the directory of the excel file. 
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Step 5: After importing the file, make a validation for the imported data. 
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Step 6: Check if you have a rejected support marks or not, and check the 

accepted support marks. 

 

 

Step 7: From Project tab select Build to create all items inside PSG tree 
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Step 8: After Creating the 3D model of the Pipe Support and the 2D Drawing, 

you can open both separately from the node shortcut menu. 
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Step 9: You can Export both of the 3D model, 2D Drawing and Sheet metal 

Development from the shortcut menu. 
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Select the exporting directory 

The following images for the available formats for Assembly and drawing 

that you can export 
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Step 10: You can create a collection assembly which includes the all-support 

marks in your project with the required quantities. 
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Step 11: You can create a collection of drawings in a single drawing with a 

multiple sheet. 
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Application Themes 

Light, Blue, Midnight, Emerald Green and Dark Themes are available, you can 

choose between them. 
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Project Setting 

A) From the Project menu you can select Settings to get the Project Settings 

form. 

From the Project Setting form you can control the output content in the 

drawing title block. 

• Drawing Approved By. 

• Drawing Checked By. 

• Drawing Prepared By. 

• Drawing creation Date. 

• Drawing No. 

• Drawing Name. 

• Project Name 

• Job No. 

• Client. 

• Manufacturer. 

• Specification Name. 
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B)  You can use your Custom Template to import the project Title block 

instead of PSG standard Title Block. 

 

C) Assembly Collection Setting 

You can control the spacing between the element and its pattern and 

between the element and the second element by modifying the 

values of Pattern Spacing & Assembly Spacing respectively. 

 

 

D) Direction of Pattern. 

You can change the direction of the pattern for the element itself and 

between the element and the following one. 

 

E) Drawing and Assembly Options. 

You can automatically close the generated drawings or assemblies by 

selecting a check box. 
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Assembly Collection 

The Assembly Collection tool in PSG is an advanced feature designed to streamline 

the process of managing multiple Pipe Support components within a project. This 

tool allows users to consolidate all Pipe Supports and sheet metal components into a 

single, unified assembly—referred to as a Collection Assembly—making it easier to 

organize, study, and optimize your designs. 
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Key Features of Assembly Collection 

1. Unified Assembly Management 
o Combines all Pipe Support components into one cohesive assembly file. 
o Ensures all parts are properly organized within a single structure. 

2. Quantity Management 
o Automatically calculates the required quantity of each component. 
o Provides an accurate overview of the materials needed for the project. 

3. Ready for Nesting Study 
o Prepares the Collection Assembly for nesting, ensuring material utilization is 

optimized. 
o Seamlessly integrates with nesting tools, reducing setup time and potential 

errors. 
4. Comprehensive Bill of Materials (BOM) 

o Generates a complete Bill of Materials for the project. 
o Includes detailed information such as part names, dimensions, materials, and 

quantities. 
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Benefits of Using Assembly Collection 

• Efficiency: Streamlines workflows by reducing manual efforts in organizing and 
tracking components. 

• Accuracy: Ensures precise material calculations and BOM generation, minimizing 
errors in Pipe Supportion. 

• Optimization: Enhances nesting efficiency by preparing all components in a 
consolidated format. 

 
Tips for Optimal Use 

• Ensure all components have proper material assignments before adding them to the 
Collection Assembly. 

• Regularly review the generated BOM to verify quantities and dimensions. 
• Use the nesting study feature to optimize material usage and minimize waste. 

 

The Assembly Collection tool in PSG is a game-changer for project management and 
material planning, offering seamless integration with your workflow. By consolidating your 
design into a single assembly, it not only enhances efficiency but also ensures that every 
aspect of your project is accounted for, from design to proPipe Supportion. 
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Drawing Collection 

The Drawings Collection Tool in PSG is a powerful feature that simplifies project documentation by 

consolidating all drawings related to a project into a single file with multiple sheets. This functionality is 

especially beneficial for projects with numerous components, enabling seamless management, sharing, and 

printing of drawings. 
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Status Bars  

PSG features dynamic status bars that provide real-time updates about the 
progress of your project. These bars are located at the bottom of the user 
interface and are designed to give users a clear overview of the number of 
accepted and rejected support marks, as well as the total number of created 
supports. The status bars help monitor the status of your project and offer 
insight into your work's progress. 

 

Accepted Support Marks Status Bar 

The Accepted Support Marks Status Bar is designed to provide users with real-
time feedback on the status of the accepted support marks. This bar shows the 
following key information: 

• Total Accepted Support Marks: The total number of support marks that 
match the specifications and have been validated as accepted. 

• Created Accepted Support Marks: The number of accepted support marks 
that have already been created, including the 3D models and 2D drawings. 

• Remaining Accepted Support Marks: The number of accepted support 
marks that still need to be created. This helps the user track the remaining 
work in the project. 

• Approximately Remaining: Approximately Remaining time to complete the 
total number of the support marks. 

• Accepted List – Export: You can export a list of the accepted supports. 
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 The status bar serves as a quick reference for understanding the completion 
level of the accepted support marks in your project. It updates automatically as 
new support marks are created and validated. 

 

Rejected Support Marks Status Bar 

The Rejected Support Marks Status Bar tracks and displays the status of rejected 
support marks. These are support marks that do not match the specified criteria 
and, therefore, have not been accepted into the design. The status bar provides 
the following information: 

• Total Rejected Support Marks: The total number of rejected support marks 
in your project. These are marks that have been flagged as non-compliant 
with the specifications. 

• Quantity of the Support Marks: The number of rejected support based on 
validation or specification mismatches. 

• Rejected List – Export: You can export a list of the rejected supports. 
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This status bar provides users with a clear view of how many support marks are 
not accepted, allowing them to focus on resolving discrepancies or reviewing 
their design. 
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Abort 

The Abort feature allows you to interrupt the processing of multiple Pipe Support 

models running in Autodesk Inventor. By using the Abort command, you can stop the 

operation after the current Pipe Support model and its associated drawing are 

completed, giving you control over the workflow without losing progress on the 

active task. 
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Reset 

The Reset feature enables users to clear the entire project by deleting all associated 

Autodesk Inventor assemblies, parts, and drawings. This function provides a clean 

slate, allowing users to restart the project from the beginning without retaining any 

previous data. Use this tool cautiously, as it will permanently remove all existing 

project files. 

 
 

Download Supports 

The Download Supports feature allows users to download newly added support 

types that have been uploaded to our cloud server. This ensures that your PSG 

software always stays up to date with the latest support models and configurations. 
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Service Health 

The Service Health feature allows users to monitor the connection status between 
CranePro 3D and its servers. This ensures that the application is running smoothly and can 
access the necessary online services. 

Currently, two servers are available: 

• Primary Server – displayed on the first line. 
• Secondary Server – displayed on the second line. 

For each server, the system displays the response time, which indicates how long it takes to 
establish the connection. A lower response time reflects a faster and healthier connection. 

By regularly checking the Service Health window, users can quickly identify if there are any 
connectivity issues and determine whether the system is operating on the primary or 
backup server. 

 

 
 

 


